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1 Flow of Analysis Operation
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Flow of Analysis Operation

In this chapter, the operation flow of LabSolutions GPC is explained as shown in the following chart.

In LabSolutions GPC, adding to the parameters for LabSolutions, you set parameters for calibration curve,
molecular weight calculation, etc. in a method file. You can create calibration curves in the [GPC Postrun]
program, and once you have set all these parameters, you can perform GPC calculation, such as
molecular weight calculation, while performing data acquisition by using the method file. This Quick
Manual describes the procedure for creating a calibration curve, a process inherent to GPC. For other
operations, refer to the "LabSolutions Operation Manual" or the "LabSolutions GPC Instruction Manual”.

Setting the analysis conditions

LabSolutions
[Realtime Analysis] - [Data Acquisition]
LabSolutions Method file (.lcm)

v

Analyzing standard sample

LabSolutions [Realtime Analysis] - [Data
Acquisition] or [Batch Processing]
LabSolutions Data file (.Icd), Batch file (.Icb)

\ 2

Setting peak integration parameters
[GPC Postrun] - [GPC Data Analysis]
Modifying the method in the data file (.lcd)
Can modify the method file (.lcm)
accordingly

Creating reports

* [GPC Postrun] - [Report Generator]
Creates a report format file (.Isr) for GPC
Creating calibration curves Postrun data.
[GPC Postrun] - [GPC Calibration Curve]
Creates a calibration curve in a method file
(.lcm) using data files (.Icd) of standard
samples.

| @

v

Analyzing unknown sample

LabSolutions [Realtime Analysis] - [Data
Acquisition] or [Batch Processing]
Data file (.Icd), and Batch file (.Icb)

v

Viewing results

[GPC Postrun] - [GPC Data Analysis], and
[GPC Data Comparison]

Data file (.Icd)

Reanalyzing the results

[GPC Postrun] - [GPC Data Analysis] or
[Batch Processing]
Data file (.Icd)
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2  Creating Calibration Curve

H Opening a File for Editing

1 Display the [LabSolutions Main] window.

.11 LabSolutions M System Administrator)
File View Window Help

Data Analysis Todls

& @ =

Postun Browser  GPC Postun

Data Analysis Todls

& @ =

et ruments Postrun Browser  GPC Postun

3 Double-click @ (GPC Postrun).

.11 LabSolutions M System Administrator)
File View Window Help
@7

Data Analysis Todls

“ RN

et ruments Postrun Browser | GPC Postun

Ok

Prziri

The [GPC Postrun] program will start.




2 Creating Calibration Curve

Click ;7os7" | (GPC Calibration Curve) from the [Main] assistant bar in the [GPC

Curve
Postrun] program.

——i x|
L]

GFC Data
Analysis

=
GPC Data
Comparison

=

Postrun Batch

E

The [GPC Calibration Curve] window appears.

[ GPC Postrun Analysis (System Administrator) - [GPC Calibration Curve] = R
{[E7 File TableEdit View Method Data Tools Window Help [==][x]

I0D3H &«& o | m @]
Folder: B Calibration Curvs Wiew B Calitration T able Yis Eaven B Eal
i\ abSolutons\sample\.c -] Comment
Filename WModified Date # | Timefmin) | Molecular Weight | Active
&) Demo_Method  3/26/20111207 P
i Demo_SysSuit_...  3/26/2011 12:07 ) 0
EGPC_Method  1/20/2014 4:22 | Time - 0.00T " nten 0.0 |-
2)PDA Method  3/26/20111207 P
=) Tutorial_Method  3/26/20111207 P n
]
50+
25+

000000 000025 000050 000075 000100 000125 006150

B Chiomatogram View

« i v A single | A= muit [ [ sample info. |
Commert Data fie Name:
Max Intensity: 0
1o Time Tilen A
3
504 -
« [ 3
% MarkHouwinl:
. , ; ; . .
0.00000 0.00025 0.00050 0.00075 0.00100 0.00125 0.00150 Time Conversion: Pick up...
S . A ad) " PGP Calibrati.
cap
Click [Open Method File] from the [File] menu.
GPC Postrun Analysis (System Administrator) - [6PC Calibration Curve]
E}# File] Table Edit View Method Data Jools Window Help
I~ wiwaca s e :
= o |y || &
_(B Open Method File... -0
T = B Callbralion Curve View B Callbralion Tble View &3 Vicw [ Edt
[ Save Method File CrleS St
%3 Save Method Fil :

# | Time(min)| Molecular Weight |  Active

Template... d Date

By Save Method Fil
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6 Select the method file and click [Open].

Lookin: || LC - & T e m
= Name - Date modified Type
e ). 6P 1/24/2014302PM  Filefolder
RecentPlaces ) i ppea 1/24/2014 302 P File folder
J Demo_Method 3/26/2011 1207 PM  Shimadzu
| Denmo_SysSuit Method 3/26/20111207 PM  Shimadzu
Desktop GPC_Method 1/20/2014 4:22PM  Shimadzu
= PDA_Method 3/26/20111207 PM  Shimadzu
Tutorial_Method 3/26/2011 1207 PM  Shimadzu
Libraries
i~
Computer
@ a4 mn ] 3
Network
Fie name EPC_Method - Open J
Flesoftpe: [ All Method Fles ("lom:"gom) x| | Ganedd | |

[{// NOTE

You can select either LabSolutions method files or those from older software versions.

B Adding Data Files for Use in Creating a Calibration Curve

1 Click [Data File List] from the [Data] menu.

IDeH| «o Bl
2l ‘

Eia THE LI Op et

A —) Sl | || @ ®
A8 |

Folder: = Calbration Curve View B Cabration Table View P Ed
[ sbsolutons\samplec - Commert:
| Filename Modified Date | # | Weight | FEmor(n) | Pea

2 Click [Add].
M

Data File List

[Case ) o= | o] [oos J [ ]
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2 Creating Calibration Curve

Select the standard sample data you wish to use for creating calibration curve, and click
[Open].

(%} Add Data File =
Look in: Lc - @3z E
T Name B Date modified Type *
Y ] Background 3/26/2011 1207PM  Shimay
Recent Places .Y pemng_Data-001 3/26/2011 1207 PM Shima
- | Deme_Data-002 3/26/2011 1207PM  Shimal=
| Dema_Data-003 3/26/20111207PM  Shimay
Desktop |1} Demeo_Data-004 3/26/2011 1207PM  Shimai_
S | Dema_Data-005 3/26/20111207PM  Shima
= | Deme_Data-006 3/26/20111207PM  Shima
Libraries | Demao_Data-007 3/26/20111207PM  Shima
= GPC_Data-001 1/20/2014 422 M Shimar
A | GRC_Data-002 1/20/20144:22PM__ Shimar
Computer || GPC_Data-003 1/20/2014 422 PM_ Shimar
- [ GRC Data-004 T/20/2014 4:23 P Shiman
‘..4‘ 4'“? GPC Data-005 - L20214422PM Shima 2
Network
Fie name: "GPC_Data-004)cd" "GPC_Data-001Jcd” 'GF + _
Files of type. LC Data File ["lcd) -] | Cancel |

Verify that the data file of the standard sample is displayed in the data file list, and click
[OK].

Calibration Curve @

Data File List

(GPC_Data-001lcd
GPC_Data-002Jcd
GPC_Data-003Jcd
GPC_Data-004 Jcd

[ Add. | [ Dete | |[ ok ])[ Cancel | [ Hep |

Click [Edit] in the [Calibration Table View] screen.

[ GPC Postrun Analysis (System Administrater) - [GPC Calibration Curve - GPC_Method.lem] |- =]

7 FEile TobleEdit View Method Date Tools Window Help NEIE

® O 2 iRe -] [ont - )
=l
Folder: 0 Calibration Curve Wiew B Calibration T abls View
PC Calibration] | (. abSolutonsiSample.C - Comment
Filename Modified Date # | Weight | Evor(t) | Pes
= %) Demo_Method  3/26/2011 1207 )
PR | | 2 Demo_SysSuit_... 3/26/2011 1207 P log(i.) i
e S GPC_Method  1/20/2014 4:22 P W R IR 0000 .
< PDA Method  3/26/2011 1207 P| 7
) Tutorial_Method  3/26/201112:07 P| .
6.
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6 Click [Pick up] in the [Calibration Table View] screen.

4.5
40q %
r T T T
180 125 120 175 min
B Chiomatogram Visw
‘ i v i singie | 2= Mt [ sampleInfo. |
uRlY Max Intensity : 10,143
Commert tem Time TS0 nten 2=
10313
l2c1)
1(21) o
ES |
g ] v
B -~ % Marls-Houwinic: OFF
125 180 s 200 Time Conversion: OFF
J

E By . ] il " EIGPC Calbret |

7 Click [All peaks] or [Select peaks].

Select [All peaks] when importing data of the whole retention time, and select [Select peaks] when
importing data for a certain time range. When [Select peaks] is selected, use the mouse to specify the
range on the chromatogram.

((GPC Method Edit (=3

Peak retention time is imported into the Calibration table.
Press the [Select peaks] button and specify the time range by
dragging the cursor on the Chromatogram view to select
peaks.

ﬂ Alpeaks | [ selectpeaks ]] [ cancal |

8 Click [New] or [Add].
Select [New] when importing peak data after deleting an existing calibration curve. Select [Add] when
adding peak data to existing calibration points.

T
GPC Method Edit (=3
Retention Time(min) Height
14797 5107 = New
15 559 5912
16.239 £299 ————
16.883 6898 | Replace |
17 476 7897
18.032 9085
18495 9138
19.005 10104

ere are 8 peaks within the spedfied time range.
mport these peaks into the Calibration table?




2 Creating Calibration Curve

Set the parameters not yet defined in the calibration curve table, such as molecular

weight values.
(33 GPC Postrun Analysis (System Administrator) - [GPC Calibration Curve - GPC_Method.lem] =1
W Eile TableEdit View Method Data Tools Window Help [=[E][x]
D3d|&@ -] [om PN
=l x|
Main Folder: O Calibration Curve View O Caibration T able Yiew
PC Calibration| [r‘v
p
Filename Modified Date # “"? ’;{)‘3 Molecular Weight | Active
v
) Demo_Method  3/26/2011 12:07 P 14797 553000 v
3] Demo_SysSuit_...  3/26/2011 12:07 P log(W.WY.) 15,558 350000 v
1 GPC_Method 1/20/2014 4:22 P 1.0 Al T2 M oWV ) LLUR IS 16.239 186000 ol
i ‘ 76888 100000 v
5PDA_Method  3/26/201112:07 P i i
) Tutorial_ Method  3/26/2011 12.07 P 2032 23700 7
0] 8 8455 20| @
5 9.005 5800 v
]
0.0+
0.5+
EXE g
130 180 170 120 " min
O Chiomatogram View
- = . J_ single | F= Mt Sample Info. |
. uRW Max Intensity : 10,143
Commert 2(#}) Time 18875 Inten 0054 .
36#1)
1021y
1(#1) |
5]
o < [ »
Mark-Houwink: OFF
130 Wda e 180 170 140 180 200 Time Conversion: OFF
[E#GFC Calibrati
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B Setting Data Processing Parameters

1 Select [Data Processing Parameters] from the [Method] menu.

em Ad Gl libratior
B File Table Edit View [Methad| Data_Tank Window _Heln

: X sl
038 &0 |([@Esresgtmes ) -] [ BEAEN G
Elel Analyze
Dats Acquisition Settings » B Calibration Curve Yiew 8 Calibration T abls View [ Edt
% QNQC Paramets. A —
- &5 System Suitability Settings... Time(min) | Moleculor Weight | A
1 10.000
&% Demo_Method  3/26/201112:07 PH | | = S

2 Click [Advanced] in the [Integration] tab.

Integration | GPC Calaulation | GPC Calibration Curve | Identification | Quantitative | Performance |

Channel: [rD —ch1 |

width: 5 sec Copy to All Channels

Slope: 200 wvjfmin

Drift: 0 uvjmin —JL“L
Program

T. DBL: 1000 min

Min. AreaHeight: 1000 counts MNoise,Drift Calculation. ..

Calalatedby: @ Area () Height Adyanced. ..

[lasto @ MaxPesk [6 | counts O RelatvetoManPesk (1 | %

ok ][ cancel ][ appv |[ e

3 Enter the number of slices in [Max.Slices].
Set the maximum value: [50000].

Max. Slices @ 50000

ik

Peak Top Detection:

RT Compensation Mode:

Min. Area/Height is made effective in manual integration

10



2 Creating Calibration Curve

Check [GPC Calculation] in the [GPC Calculation] tab.

Data Processing Parameters @

Integration | GPC Calculation | GPC Calibration Curve | Identification I Quantitative I Performance

Mamme: Channel: [RID -Cht -
) Fackor: !

Standard polymer Time Correction
alpha: 0 il @ Mone () Internal Standard  (0) GPC Control sample
K 1 dlfg 1 dufg Settings. ..
Flow [ sensitivity Compensation{RID) Settings. ..
() Use Purnp Flow L fmin

[ ar/mw Range Settings... |

@ Manual Input 1 L fmin

Molecular Weight Distribution
@ Molecular Weight  (7) Degree of Polymerization

Molecular Weight per Degree of Polymerization: 1

OF ] [ Cancel ] [ Apply ] [ Help

Select the [Curve] type in the [GPC Calibration Curve] tab, and click [OK].

Dats Processing Parameters [zl

Inkegration | GPC Caledlation | GPC Callbration Curve | identification | Quantitative | Performance |

Channel:  |RID-Chi -
Curve:
[ [ard Order ; ax~a+hx 24cxed - ]
TaMIT: 0 min (X=x-T.LIMIT)
[ wimight [ Mark-Haouwink.
[] Time is averaged for the same M., [] Time Conversion | Settings...

Mark-Houwink conversion parameters

Standard polymer Unknawn palymer
aslpha: o 0
K 1 dua 1 dja

[ or )] camel || apel [ he

11
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6 Verify the calibration curve created in the [Calibration Curve View] screen.

GPC Postrun Analysis (System Administrator) - [6PC Calibration Curve - GPC_Method.lcm] =2 EoR()
File TobleEdit View Method Data Tools Window Help [=1=]=]
E1 = ARG EN - F =11 ]| IR G -] e z)|» || @ |
= =l [~ \
Main Folder: B Calbration Curve View 3 Caibration Table View [ Edit
TR | eerr— |y S LAt e
lC:\ -2 a b c=-02672138 Bl
4 5242068 ] ;
Filename Modified Date T.LIMIT = 0min
[l Demo_Methed  3/26/201112:07 P R°2-059577%5 R=03953338  Dispersion =00151087
[l Demo_SysSuit_...  3/26/2011 12:07 P| QM W.)
[ GPC_Method 1/25/20141:39 Pl I L TR L |~
IPDA Method  3/26/201112:07 P) 70]
= Tutorial Method  3/26/201112:07 P
65 g
El
0]
m
554
5.0
45
0] g

100 125 150 175 min

B Chiomatogram Yiew

« i 3 J_ singe| 2= Mult [ sample 1nfo.
Comment uRIU Max Intensity - 10,143
4[#?’ Tme 9736 Inten. 004 .
3#1) e
s (A B B I o
5
10 <[ r
Mark-Hounink: OFF
100 135 150 e Time Conversion: OFF [Pickwp. |
i By . B[ il B GPC Calirati..

L{,’ NOTE

To modify the calibration curve, configure the settings again in the [Data Processing Parameters] -
[GPC Calibration Curve] tab.

Click [Save Method File]

from the [File] menu.

[ GPC Postrun Analysis (System Administrator) - [GPC Calibration Curve - GPC_Method.lem] fela ==
Eile| Table Edit View Method Data ITools Window Help [=I=][x]
|| Mew Method File Ctrl+N v] [Dﬂ v] o | |
¥ Open Method File... Crl+0

3 Close Method File O Calibration Curve Yiew O Caibration T able Yiew @ Edit
7| }E_Save Method File Ctes |- 1| |3 Order : aX"3+bX"ZaXed (=T LIMIT) ]
: ST | el R L |
=t d -=5.242068 = = -
2 # | Time(min) | Molccular Weight | Active
£y Save Method File As Template... Rt TLMIT ~Drmin
gl v VEthoC el smpats o R"2-09997795 R-0999889¢ Dispersion = 001510879 10.000 20000000
Load Data Method Parameters... 2 14.797 853000
14 4:22 g(M.W.) 15559 380000 [v]
Merge of CLASS GPC Method File... 1410:5 Tene 10 BTl VY T2 . 16.239 186000 i
16888 100000 | []
Import CLASS GPC methed file... ;
Impor methed file, 14 4:22 7.0 7476 48000 [¥]
Select Project(Folder)... 1120 ool 8.032 23700 )
I3 File Search e 8 13.455 12200 @]
- 11120 el El 9.005 5800
Audit Trail Log... 11120, |
& Print Setup... 12819 55y
Print Graph Image » 11120 Sl
- 14123
[ Method File Properties.. E
11120 45
1 GPC_Method 11120 <
11120 40 g
11120 ; H ; ;

The calibration curve is saved in the method file.

A method file with the calibration curve configured has been created. By using this method file to analyze
an unknown sample, GPC calculations can be performed. (This can also be carried out online in

conjunction with data acquisition.)

12




3 Checking the Results

3

Checking the Results

The GPC calculation results can be checked by opening the data file from the [GPC Data Analysis] window
or the [GPC Data Comparison] window.

B [GPC Data Analysis] window

{@l File View Method Tools Window Help

[ GPC Postrun Analysis (System Administrator) - [GPC Data Analysis - GPC_Data-005.lcd]

Log of Data Acquisition...

[Sarmple Mame]
GPC_Dema

6 <[4 # i[RD M AR AREE
=l =l
Eolder: B Chromatogram Yiew
GPC Analysis | | .y abSolutions\SamplelL.C - uRl Max Intensity ;1,678 log(M.W.} [Method Fie]
[ J - R = L . GPC_Methedlcm
B Filename Modified Date * R [ [OviginalMethod Fie]
4 ~ Hyslsric-scid
Dma;\;“ [ Background 3/26/2011 12:0 05 [so | Theenessain
1] Demo_Data-001  3/26/2011 120 . g [arvleane)
|+ Demo_Data-002  3/26/201112:0 : Loo E‘ =
G2 1] Demo_Dats-003  3/26/2011 12:0 0.0 50 10.0 15.0 200 250 min LS;EDIE D]
o ,J\DEmu_Data 04 3726/2001120 - ST R
[+] Demo _Data-005  3/26/201112:0 2] Time 6.148 Inten. 0008 logWW.) 6.721 . |Acquired by]
|17 Demo_Data-006  3/26/2011 1201 RID a min
H-'* ] Demo_Data-007  3/26/201112:0 K Lso ~ [Datedeguicd]
25 12014 1. T A7/ AT A
PR | [ GPC Data0o1  1/25/20041:30
Intsgration |1 GPC Dats-002  1/25/20141:39 v o [Sample Typel
y 725,204 1: s Unknown
w3 GPC_Data-003  1/25/20141:39 0 A T e o P =
|1 GPC_Data-004  1/25/2014 1:39 ——
I GPC Data 005 17252014 158 8 Molecular wieight Distriotion Yiew
|1 PDA_Demo Dat... 3/26/2011 120 L T
|17 PDA_Demo_Dat... 3/26/2011 12:0 100 .
|1 PDA_Demo Dat... 3/26/2011 120 -
2
| PDA_Demo_Dat... 3/26/201112:0 g
T MnAnA Neeeo s AmE a1 ©
il i 5| 1
= -
Detector A{Ch1) - |
Max Intensity © 13,018 o]
E !
25+ a )
= .
5 o
= z
“‘ E al
100 3’5 40 45 50 55 60 Toath W)
PC Data A
To display the calculation results, select the appropriate item from the [View] menu.
Click the appropriate item from the [View] menu.
38 GPC Postrun Analysis (System Administrator] - [GPC Data Analysis - GPC_Data-005.Icd)
File | View| Method Tools Window Help
3 et [rw—l L PSR
L] Peak Table... 5
L& Molecular Weight Distribution Table.. || 5| B Cometomremview
1 RT/MWTable.. |
i = j uRIU Max Intensity : 1878 log(M.W.) g;éhadeflgsajlcm
Cnromatogram view Q = Time 10.574 Inten. 0007 Tog(M W] _ 0.30 o e
Molecular Weight Distribution View » R [ [Drigial Method Fie]
e N A o Apahaaric-scid kem
P
5

S 5} ManualIntegra

tion Bar

D 1

13



Click the appropriate tab in the [Result Display] screen to check the contents.

[ |
5| Result Display(Average Molecular Weight) (=l

Channel:
Slice Data | Peak Table | Average Molecular Weight ‘ RT/Mi Range Table ‘

# Number Ave. M.W. (Mn) | Weight Ave. MW. (Mw) | Z Ave. MW. (Mz) | Z+1 Ave. M.W. (Mz1) | Viscosity Ave. M.W. (Mv) [
Total 96308 646630 1292338 1893795 [1]
1 96308 646630 1232338 1893795 0

Close

B [GPC Data Comparison] window

i o)
[} GPC Postrun Analysis (System Admini [GPC Data Compari [folfe-] =)
&} File View Process Tools Window Help == ]

?
0 Data List View O Molecular Weight Distibution View(Data Flai)
p No_ File Name Detector-Channel Method File 1o
T |GPC_Dala 001icd RIDChl GFC_Methodlom | GF -
2 |GPC_Dat=002Icd RIDChi GPC_Methodlom | GF
Fil Modified Date * — —
lename fehle i 3 [GPC_Date003/cd RIDChT GPC_Wethod lom | GF
%] GPC_Data-001  1/25/20141:39 4 |GPC_Dala004/cd RIDCh GFC_Methodlom | GF 75
i) GPC_Data-002 /2014139
| GPC_Date-003 1. a
|1 GPC_Dats-004  1/25/20141:39 -~ 5
| GPC_Data-005  1/25/20141:54
WS | [ PDA Demo Dat.. 3/26/2011120 n
] PDA_Deme_Dat... 3/26/2011120
] PDA_Demeo_Dat... 3/26/201112:0 o
|47 PDA Deme Dat... 3/26/201112:0/=. o
] PDA_Deme_Dat... 3/26/2011120 ; ‘ ;
i+ PDA_Demo_Dat... 3/26/201112:0 < I 3 40 50 log(W.\A)
] PDA_Demeo_Dat... 3/26/201112:0 B Chiomatogram Yigw{Data Plat) & | B Cumulative Percent View
) Tutorial_Std001  3/26/2011 120
) Tutorial 5td002  3/26/201112:0 o o m o
1. GPC_Data-001.Icd RID-ChT [624 Level o 1: GPC_Data-001.lcd RID-Ch1
1) Tutorial Std003  3/26/201112:0 4 SPE:DE‘:_M et cvc § 8@5—8%‘335 }Eﬂ 3:& Em
! 3: GPC_Data-003.lcd RID-Ch1 ._Data-003.|
&5 Tutorial 5008 3/26/201112:0 & GPCData.004 Iod RD_Ch1 75| - 4 GPC_Data-004.Icd RID-Ch
) Tutorial _Std005  3/26/201112:0 75
Mraiocianns  mesmnaann |
< .
RID(Ch1) - ol a 504 m
Max Intensity : 8,094
25 =y
o] r_,__._a‘.,: g 0
Il‘l] 5I|] 1D‘D 15‘[} ZD‘D 2.‘;!} ‘mm 4I|] S‘Il Ill‘)g(MW)
5 GFC Data C.

Multiple data results can be checked in this window.
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